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Abstract: This application note explains how to evaluate the DS28E05 1-Wire® EEPROM on a Windows® PC. The following discussion outlines
the hardware and software required along with step-by-step setup instructions. Useful links to download hardware data sheets, evaluation
software, and the correct device drivers are provided, and a detailed description of the evaluation software is given.

Introduction

The DS28E05 can be evaluated on a PC without the need for a specialized evaluation (EV) kit. The hardware required to evaluate the DS28E05
in a TSOC package can be readily obtained through Maxim Integrated’s online store. The hardware consists of an evaluation (EV) board with

RJ11 cable (DS9120P), a Maxim 1-Wire® adapter module that connects the board to the PC (DS9481R-3C7), and a DS28E05 in a TSOC
package. All three hardware components are listed in Table 1.

Table 1. Required Hardware for PC Evaluation

Qty Description

1 DS9120P+ EV board with RJ11 cable
1 DS9481R-3C7+ 1-Wire USB adapter with cable*
1 DS28E05+ in a TSOC package

+Denotes lead(Pb)-free and RoHS compliant.
*The DS9481R-3C7+ is the only 1-Wire adapter electrically compatible with the DS28E05.

See Figure 1 for a picture of the stand-alone EV board with RJ11 cable and Figure 2 for a picture of the EV board with USB cable that plugs
into the PC.

Figure 1. The DS9120P EV board with RJ11 cable. Figure 2. The DS9481R-3C7 1-Wire USB adapter with cable.

The DS28E05 features 112 bytes of user memory organized as seven pages of 16 bytes. Each page can be write-protected or set into EPROM
emulation mode. The evaluation software runs under Windows® 8, Windows 7, Windows Vista®, or Windows XP®, providing a handy user
interface to exercise the features of the DS28E05. The evaluation software is available for download.

Note: In this application note, text in bold refers to either references, such as figures or tables, or to items directly from the EV kit software. Text
in bold and italicized refers to items from the Windows operating system.

Driver Installation Quick Start

1. Before beginning, make sure the following equipment is available:
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o DS9481R-3C7 1-Wire adapter with USB cable

o DS9120P EV board with RJ11 cable

o DS28EO05 in a TSOC package

o PC with a Windows 8, Windows 7, Windows Vista, or Windows XP operating system and a spare USB port

. Do the following before connecting to the PC:

a. Insert the DS28E05 in the TSOC socket on the DS9120P EV board.
b. Connect the EV board to the DS9481R-3C7 1-Wire adapter with the RJ11 cable.
c. Wait to insert the DS9481R-3C7 into the PC until prompted by the software installation.

. Follow the steps below to install the PL-2303 Prolific Driver (for the DS9481R-3C7). Many Microsoft® operating systems have a version of

the PL-2303 Prolific Driver preloaded. Plugging in the device for the first time often completes the installation. If the Microsoft operating
system in guestion cannot install the device driver, then do the following:

a. Unplug the DS9481R-3C7.

b. Download the Prolific Driver.

c. Unzip the archive and Run the executable file that begins with “PL2303_Prolific_Driverinstaller”.

d. Follow the directions of the Install Wizard until the PL-2303 USB-to-serial driver install is finished. Close by clicking the Finish button.

. Follow the steps below to install the 1-Wire Drivers software package. For expanded installation details, see tutorial 4373, “OneWireViewer

and iButton Quick Start Guide”.
a. Download the 1-Wire Drivers software package.
b. When prompted with the question Do you want to run or save this file?, select Run.
c. When you get a security warning that reads Do you want to run the software?, select Run.
d. Read and check the box if you accept the license agreement. Click Install.
e. Click the Finish button to exit the Setup Wizard.

. Microsoft .NET Framework Version 3.5 SP1 is required for the program to run. To check whether it is installed, look in the Control Panel

under Add/Remove Software. If .NET is not listed, it is not installed. Download and installation instructions, go to
http://msdn.microsoft.com/en-us/netframework/aa569264.aspx.

. Insert the DS9481R-3C7 into a spare USB port on the computer.

Software Quick Start

1.

After downloading the software from the URLSs listed above in the Driver Installation Quick Start section and unzipping the files into a folder,
start the EV kit software by double-clicking the file DS28E05_Evaluation_Program.exe. Note: Make sure that the hardware has been
correctly connected.

. Software quick setup

a. In the 1-Wire Adapter group box on the Setup tab, the Adapter Port Type is fixed at USB (COM) with the Adapter Part # of
DS9481R-3C7. The Adapter Port is a COM port mapped by the Prolific device. Click on Open Adapter/Port or use the Auto-Search
button. If successful, the Status field next to the Open Adapter/Port button displays Success.

b. The device selection options are displayed in the Device Selection Methods group box in the Setup tab.

c. The default setting for the EV kit software is Match-ROM in the ROM Selection Method drop-down list. Also, the Use Search-ROM
to find first available EVKit device is checked by default. Leave these default selections for quick setup.

d. Once the adapter/port has successfully been opened, the Device Selection drop-down list is automatically populated with the unique
ROM ID of the available DS28E05s. If no device is found on the 1-Wire, the selection is blank. In that case, insert the device and click
the Refresh Selection button. A device must be present in order to proceed to the Memory tab to exercise the device.

e. Once the device has been selected, click on the Memory tab. Select the memory range in the Memory Resource Selection drop-
down list.

f. Once a memory range has been selected, the available commands appear in the Commands group box below the Memory Resource
Selection. The commands appear as buttons.

g. Select a command by clicking on one of the command buttons. The button is highlighted in yellow to indicate which command is
selected.

h. Once a command has been selected, the Options group box below the command buttons is displayed with the required options for

the command. Select the options and click the Execute Command button to execute the selected command with the options provided.

. The output of the selected command is displayed in the Log group box in a scrollable field. The Key describing the output in the log is

provided at the bottom of the Log group box. The window can be resized or maximized to enlarge the Log group box.

j. The log can be copied to the clipboard through the File—+Copy Log to Clipboard menu item. The log can be cleared through the File
—+Clear Log menu item.

k. The program can be ended through the File=>Exit menu item.

Detailed Description of Software

The software program’s main window (Figure 3) contains three tabs: Setup, Memory, and Raw 1-Wire. The starting tab is Setup, which
contains the 1-Wire adapter/port and device selection options. The Memory tab (Figure 4) contains the main demo with four areas from top to
bottom: Memory Resource Selection, Commands, Options, and Log. The Raw 1-Wire tab (Figure 8) contains buttons and fields to send and
receive raw 1-Wire communication.

Page 2 of 9


http://files.maximintegrated.com/sia_bu/public/PL2303_Prolific_DriverInstaller.zip
http://www.maximintegrated.com/an4373
http://www.maximintegrated.com/an4373
http://www.maximintegrated.com/1-wiredrivers
http://www.maximintegrated.com/1-wiredrivers
http://msdn.microsoft.com/en-us/netframework/aa569264.aspx

File Help
Setup | Memory | Raw 1:Wie |
—1-Wfire Adapter

Adapter Port Type Adapter Patt & Adapter Port

USB Com) = | DS9481R-3C7 COME > E Auto-Search I

Status
Open Adapter/Port Success I™ Autc-Open
[~ Device Selection Methods
ROM Selection Method

Match-ROM  *|  WARNING. use SKIP-ROM only on networks with only 1 device!

[T Use Resume' command when possible

W Use Search-ROM to find first available EVKit device (Recommended)
D528E05 Device Selection

[0 076400 0000 00 11 -] Refresh Selection |

(0) non-DSZBE0S Devices found on network

[ osses7u_psseaxt coms Nomal y
Figure 3. The DS28E05 EV kit software: main window Setup tab.

The software window contains a menu at the top as seen in Figure 3. The log can be copied to the clipboard through the File=+Copy Log to
Clipboard menu item. The log can be cleared through the File—Clear Log menu item. The Help menu displays the version of the software.
The File=>Exit menu exits the EV kit software.

Setup Tab

The Setup tab (Figure 3) contains two sections: 1-Wire Adapter and Device Selection Methods.

1-Wire Adapter

The 1-Wire Adapter group box includes adapter type and port selections. This setup is required before performing operations on a connected
device. Only the Adapter Port Type of USB (COM) is supported with Adapter Part # of DS9481R-3C7. Once the Adapter Port is selected,
click on the Open Adapter/Port button. If the adapter is detected, Success is displayed in the status field to the right of the button. If the
adapter is not detected, an error message is displayed. If this happens, fix the problem and click the button again. Optionally, the Auto-Search
button can be used to search through all available COM ports to find the DS9481R-3C7.

The Auto-Open checkbox instructs the program to automatically open the selected adapter and port when the program starts. This should be
used if the adapter port combination is not expected to change often. The Open Adapter/Port button does not need to be clicked if the Auto-
Open was checked when the application started and Success is displayed in the status field.

Device Selection Methods

The Device Selection Methods group box in the Setup tab instructs the Memory tab operations on how to select the device using the ROM
(read-only memory) level 1-Wire commands. The 1-Wire protocol uses the unique 64-bit ROM ID as the network address of the device.

The ROM Selection Method drop-down list has two options: Match-ROM and Skip-ROM. Match-ROM uses the ROM ID to select the device
with the Match-ROM command. Because this operation uses the ROM ID, it needs to know this number in advance. Consequently, when
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selecting Match-ROM, the Use Search-ROM to find first available EVKit device (Recommended) is automatically checked. This operation
finds the available DS28E05 on the network and populates the drop-down list. The first device found is selected by default. If the contents of the
1-Wire network are changed, the Refresh Selection button can be clicked to refresh the list. Note that the message below the device list
indicates if there are other non-DS28E05 devices present on the network found during the search. The Skip-ROM option calls on the Skip-ROM
command to select any device present. This option should only be used if there is only one device present on the 1-Wire. If multiple devices are
present, they are all selected at once, potentially causing collisions. A warning message to that effect is displayed if potential conflicts are
detected when changing to the Memory tab.

The Use 'Resume’ command when possible checkbox instructs the Memory tab operations to use the Resume command. The Resume
command is a shortcut command to select the same device that was previously selected with the ROM level command.

Overdrive speed is used at all times since the DS28E05 is an overdrive-only device.
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Figure 4. The DS28E05 EV kit software: main window Memory tab.

Memory Tab
The Memory tab (Figure 4) contains five sections: Memory Resource Selection, Commands, Options, Log, and Key.

Memory Resource Selection

The contents of this drop-down list mirror the memory resources described in the DS28E05 data sheet. Selecting a memory resource
automatically displays the commands available to operate on this memory in the Commands group box. Most ranges at a minimum provide the
Read command.

Commands/Options

Once a memory range has been selected, one or more command buttons appear in the Commands group box depending on the properties of
the memory range. Clicking on one of the command buttons highlights it in yellow. Clicking on the command button also populates the Options
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group box with fields and/or components representing the options offered for the command. The options offered change depending on the
command selected and the selected memory range’s properties. Once the options have been set, the command can be performed by clicking on
the Execute Command button in the Options group box.

The following sections list all possible commands and the corresponding options.

Read Memory

The Read Memory command (Figure 5) is applicable to all memory ranges. Possible options are the Starting Address and Read Length in the
drop-down lists. The Starting Address list is populated with all possible addresses in the selected memory range. The Read Length is
populated from one to the maximum size of the memory range.

Ex [
Starting Address |mh vl Read Length |1B vl Conﬂ:d

Figure 5. The Read Memory command Options.

Write Memory

The Write Memory command is applicable to those memory locations that are not read-only. For the DS28EO05, this is the address range of
0000h to 0073h. There are two sets of options for the Write Memory command. The first set of options pertains to a general-purpose memory
write, which writes a 2-byte segment on a data page (Figure 6). The page written to must not have Write Protect enabled. If it is enabled, the
write fails. The New Data must be 2 bytes of hex digits.

—Options

Segment [0 - New Data [s5 cc E&“":d

Figure 6. The Write Memory command Options for general-purpose writing.

The second set of Write Memory options pertains to the memory range of 0070h to 0073h. When these memory locations are written, they turn
on special options associated with each page of the DS28E05’s memory on a page-by-page basis. The Write Protect option (Figure 7) uses the
standard, general-purpose Write Memory command but formats that data to set the desired protection. The following options are provided as
radio buttons: Write Protect, EPROM Emulation Mode, and Open. Open selects no protection and is the default state. Once protection has
been set on a page, it cannot be changed.

—Options
) Execute
Field |Page 0 ~] @ write Protect o
" EPROM Emulation Mode
" Open

Figure 7. The Write Memory command Options for Write Protect and EPROM Emulation Mode.

Log
The Log group box consists of a scrollable output field and a Key to explain the output. The output field displays all communication with the
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DS28E05, along with comments to describe the operations. The log contents can be copied to the system clipboard for pasting into a document
or email message through the File=+Copy Log to Clipboard menu item. The Log can also be cleared with the File=+Clear Log menu item.
The program window can be resized to expand the Log group box for easier viewing. The text in the Log group box is also color-coded. This
color coding is preserved when copying to another program. See Table 2 for a detailed explanation of the key to the log contents.

Table 2. Log Key

Key Description
RP 1-Wire reset and presence pulse response. Color-coded blue for the reset pulse and red for the response.
RN 1-Wire reset and no presence pulse response. Color-coded blue for the reset pulse and red for the response.

1-Wire strong pullup on/1-Wire strong pullup off. Strong pullup is used to provide additional current to the device

<SP_ON>/<SP_OFF> during operations such as EEPROM write.

1-Wire write from master to device represented by a pair of hex digits showing the byte that was transmitted.

HH - write to device Valid for a line that does not begin with a comment symbol “//”. Color-coded blue.

1-Wire read from device represented by a pair of hex digits bounded by brackets “[ ]” showing the byte that was

[HH] - read to device received. Valid for a line that does not begin with a comment symbol “//”. Color-coded red.

1-Wire write bit from master to device represented by a single binary digit (1/0). Valid for a line that does not

B begin with a comment symbol “//”. Color-coded blue.
1-Wire read bit from master to device represented by a single binary digit (1/0) bounded by brackets “[ ]”

[B] showing the bit that was received. Valid for a line that does not begin with a comment symbol “//". Color-coded
red.

<<>> Indicates an error with the error message between the “<< >>". Color-coded purple.

<STD>/<OVR> Indicates 1-Wire line speed: <STD> for standard and <OVR> for overdrive. This symbol is logged before every

1-Wire reset pulse and when the speed changes as in an Overdrive Match command. Color-coded blue.

Indicates a line that is not 1-Wire communication, but is instead commentary on the operation performed. Color-

/I line comment coded black.
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Raw 1-Wire Tab
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Figure 8. The DS28E05 EV Kit software: main window Raw 1-Wire tab.

The Raw 1-Wire tab (Figure 8) provides the facilities to send and receive any raw 1-Wire communication. This can be used to recreate some of
the operations seen on the Memory tab or to experiment with other operations. It can also be used on 1-Wire devices other than the DS28E05
since it provides direct access to the 1-Wire network. All of the operations are recorded in the Log group box on the Memory tab as well as on
the bottom of the Raw 1-Wire tab for later examination and copying. The operations available on the Raw 1-Wire tab are divided into two group
boxes: Low Level and ROM Level.

Low Level

The Low Level group box provides the low-level 1-Wire primitives that can be used to construct any 1-Wire communication sequence. The 1-
Wire Reset button issues a reset low presence at the speed specified in the drop-down list to the right of the 1-Wire Reset button. The Read
Bytes button reads the number of bytes specified in the input field to the right of the button. The Write Bytes button writes the bytes displayed
in the input field to the right of the button. The Write Bytes input field is also a drop-down list that remembers all previous write byte sequences.
The Write 1 Bit and Write 0 Bit buttons write the indicated bit to the 1-Wire network.

The Start Strong-Pullup after next Byte button starts the 1-Wire strong pullup power delivery after the next communication byte (either read or
write). The Start Strong-Pullup after next Bit button starts the 1-Wire strong pullup power delivery after the next communication bit (either read
or write). The Set Power Normal button disables the 1-Wire strong pullup power delivery. The Power Down 1-Wire button powers down the 1-
Wire. Any 1-Wire operation returns the 1-Wire to a normal state.

Note: The following items in the Low Level group box of the Raw 1-Wire tab can be used for other 1-Wire products, but are not used for
evaluating the DS28E05.

e The 7V VCC Pulse (100ms) button enables a 7V pulse on the PULSE pin of the DS9481R-3C7. This is not necessary to evaluate the
DS28E05.

e The 12V 1-Wire Pulse button enables a 512us pulse on the 1-Wire to support EPROM programming. A warning message displays before
the operation completes. Do not use this feature when evaluating DS28EOQ5 as it could result in damage to the DS28E05.
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ROM Level

The ROM Level group box has 1-Wire macros that implement the 1-Wire ROM commands. These commands use the 64-bit unigue ROM ID
that each 1-Wire device is embedded with for device discovery and selection. The ROM to use with ROM commands (auto filled with Search-
ROM and Read-ROM) input field is used with the ROM macros to select a device. This field can be manually edited to input the ROM ID of the
device selected or the field is autofilled by clicking on the following buttons: Reset - Search-ROM (first), Reset - Search-ROM (next), and
Reset - Read ROM.

The Reset - Search-ROM (first) button performs the Search ROM command sequence to discover the first device on the network. The ROM ID
and the binary search sequence, not physical location, determine the order of the devices discovered. See application note 187, “1-Wire Search
Algorithm” for details.

The Reset - Search-ROM (next) button continues where the last binary search left off and finds the next device. Both of these search buttons
use the command entered in the Search Command input field. The default command is FO (hex) Search ROM. Alternately, this can be filled in
with the Conditional Search ROM command EC (hex). However, this command is not valid for the DS28E05.

The Reset - Skip ROM button sends a 1-Wire reset followed by the CC (hex) Skip ROM command. This selects all devices on the 1-Wire. It
should only be used if there is only one DS28E05 on the network.

The Reset - OD Skip ROM button sends a 1-Wire reset followed by the Overdrive-Skip ROM command 3C (hex) and changes the 1-Wire
speed to overdrive.

The Reset - Resume button sends a 1-Wire reset followed by the Resume command A5 (hex).

The Reset - Match ROM button sends a 1-Wire reset followed first by the Match ROM command 55 (hex) and then by the 8 bytes of the ROM
ID in the ROM input field at the top of the ROM Level group box. If there is no ROM ID in the input field, a warning displays.

The Reset - OD Match ROM button sends a 1-Wire reset followed by the Overdrive-Match ROM command 69 (hex), changes the 1-Wire speed
to overdrive, and then sends the 8 bytes of the ROM ID in the ROM input field at the top of the ROM Level group box.

The Reset - Read ROM button sends a 1-Wire reset followed by the Read ROM command 33 (hex) and then reads the 64-bit ROM ID of the
device. The CRC-8 within the number is checked to verify a valid ROM ID. A warning is logged if the CRC-8 is not valid. The ROM ID is also
loaded into the ROM input field to be used by the other ROM macro buttons.

Summary

This application note covered how to setup and connect the hardware and install the appropriate software and drivers. It also included a detailed
description of the evaluation software with screenshots. We found that the software covered in this application note, in combination with the
DS9120P and the DS9481R-3C7, made an excellent evaluation system for the DS28E05 on a computer running Microsoft Windows 8, Windows
7, Windows Vista, or Windows XP.

1-Wire is a registered trademark of Maxim Integrated Products, Inc.

iButton is a registered trademark of Maxim Integrated Products, Inc.

Microsoft is a registered trademark and registered service mark of Microsoft Corporation.
Windows is a registered trademark and registered service mark of Microsoft Corporation.
Windows Vista is a registered trademark and registered service mark of Microsoft Corporation.
Windows XP is a registered trademark and registered service mark of Microsoft Corporation.

Related Parts

DS28E05 1-Wire EEPROM Free Samples
DS9120P Socket Boards for Evaluating 1-Wire Devices
DS9481R-3C7 USB-to-1-Wire®/iButton® Adapter

More Information

For Technical Support: http://www.maximintegrated.com/support

For Samples: http://www.maximintegrated.com/samples

Other Questions and Comments: http://www.maximintegrated.com/contact

Application Note 5548: http://www.maximintegrated.com/an5548
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